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primatte 2.0 : create action & batch process

create an action, then batch process it
Primatte works with the Action and Batch functions in Photoshop. How varied 
your subject is determines how well an Action/Batch will work on a group of 
photographs. This kind of processing works best on a series that was taken 
under similar lighting conditions and contains similar subject matter.  

about this tutorial
In this tutorial, we will create an Action/Batch process using Primatte. First, we 
will set up an Action for applying Primatte to a photograph. An Photoshop ʻActionʼ 
will automate tasks by saving a list of commands and operations that can be replayed. 

Next, weʼll tie that Action into a Batch process to treat an entire folder of 
Photoshop fi les. A Photoshop ʻBatchʼ is a method of automating an Action to run 
on a group of photos.

[ fi gure 1 ]  A photo session that Primatte will Action/Batch properly. The same model 
appears under the same lighting and back screen. We will use this series in our tutorial.

[ fi gure 2 ]  A group of photos that 
Primatte may not Action/Batch properly. 
This is becauase Primatte determines a 
mask based on color. 

These three photographs contain 
two models with very diff erent color 
characteristics; for instance, blonde 
hair vs brunette. These models appear 
under varied lighting condiditions (note 
the white hotspots in one photo) and in 
front of diff erent color screens. 
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create an action/batch with primatte
First, letʼs create an Action that runs Primatte on a blue or green screen 
photo. Then weʼll tie that Action into a Batch process to treat an entire 
folder of photos. If you donʼt already have a group of photos to work 
with, you can download the ones that we have used for this tutorial at 
http://www.anarchyunderground.net/tutes/prim_action-images.zip.

step 01: start recording the action
Open a blue or green screen fi le that needs to be treated with Primatte. 
We have opened one of our fi les called ʻgirl-blue1.psdʼ. [ fi gure 3 ]  

Then open your Actions palette in Photoshop (Windows> Actions). 
Create a new Action and call it ʻprimatte itselfʼ. [ fi gure 4 ] When you 
click ʻRecordʼ, the Action automatically starts recording itself. [ fi gure 5 ]

step 02: unlock the default layer
Ok, Photoshop is now recording everything we do, so please donʼt click 
around outside of the following instructions. 

If your Layer palette reads as a single ʻBackgroundʼ layer with a Lock icon, 
double click the ʻBackgroundʼ layer. Then click ʻOkʼ to the dialog box. 
This will rename the layer as ʻLayer 0ʼ. [ fi gure 6 ] 

[ fi gure 3 ] The photo ʻgirl-
blue1.psdʼ used in this tutorial. 

[ fi gure 4 ] Create a new Action. 

[ fi gure 5 ] The Action auto-records. 

[ fi gure 6 ] Double-click to 
unlock the ʻBackgroundʼ layer.
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[ fi gure 8 ] Set up and apply Primatte.

[ fi gure 9a ] Our 
Primatte-treated 
image.

[ fi gure 9b ] 
Transparency 
display settings 
in Photoshop.

[ fi gure 7 ] 
First step in 
our Action.

By turning the default ʻBackgroundʼ layer into a regular layer, 
the Photoshop fi le will be able to support transparency. This 
is often the fi rst step to take when working with Primatte.              

If you look at your Actions palette, youʼll see that one step 
called ʻSet Backgroundʼ has been added. [ fi gure 7 ] 

step 03: apply primatte
Now letʼs open Primatte and set up the mask. Go to Filters> 
Digital Anarchy> Primatte. The Primatte interface opens. 

Set up the mask that works for your photo. When you are 
fi nished, click the ʻApplyʼ button (checkmark icon) to run 
Primatte and return to Photoshop. [ fi gure 8 ]

NOTE: This tutorial assumes that you already know how to use 
Primatte to create a mask. If you DONʼT know how to set up a 
Primatte mask, please read/listen to our introductory tutorials! 
They are on our website at http://www.digitalanarchy.com/
primatte/primatte_tutes.html.

step 04: return to photoshop
Back in Photoshop, the mask has been created and your 
ʻLayer 0ʼ subject is now on a transparent layer. You may see 
a gray checkerboard display around the subject. [ fi gure 9a ]

This checkerboard is simply Photoshopʼs way of visually 
displaying transparency. You can turn that display on/off  by 
going to Photoshopʼs Preferences> Transparency & Gamut. 
On the Mac, this in the Applications menu. On Windows, 
this is in the Edit menu. [ fi gure 9b ]

If you look at your Actions palette, youʼll see that a new 
step called ʻPrimatteʼ has been added. [ fi gure 10, next 
page ] The values that are listed, like Red, Green and Blue 
numbers, are specifi c to your mask settings. 

HEREʼS A TIP: If you are on Mac OS X and donʼt immediately see 
a change in the photograph, you may need to click the ʻEyeʼ 
icon in your Layers palette off , then back on. This takes care of 
a simple display glitch that sometimes occurs. If you do this, 
additional steps called ʻHide current layerʼ and ʻShow current 
layerʼ will be added to your Action. Just keep them there; those 
items wonʼt interfere with what youʼre doing.
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step 05: resave photoshop file
The fi nal step of this Action is to resave your 
Photoshop fi le. Most likely, you will want to give the 
fi le a new name and save into a diff erent folder. This 
will preserve the original greenscreen photo. Do this 
with the File> Save As command. [ fi gure 11 ]

For our fi le, we added ʻ-newʼ to the name. The name 
of the fi le is now ʻgirl-blue1-new.psdʼ. We sved the 
new fi le to a diff erent ʻblue PRIMATTEʼ folder instead 
of the ʻblue batchʼ folder that the fi le came from. 

step 06: stop recording
Now you can stop recording the Action. Click the 
ʻStopʼ icon in the Actions palette. [ fi gure 12 ]

You can now view your fi nal Action. You can also click 
around freely since this will no longer add to your 
Action list. 

step 07: prep for batch process
Once you have an Action created, you can tie its function 
into a Batch process. To do this, close any photos that you 
will want to treat. You will select them instead through the 
Batch dialog. 

On your hard drive, create a new, empty folder (if you donʼt 
already have one from Step 05). Ours is the ʻblue PRIMATTEʼ 
folder. 

The folder that we will treat was shown on the fi rst page 
of this tutorial. It is the ʻblue batchʼ folder containing 
fi ve bluescreen images. The images are similar but have 
some variation. After the Batch runs, we will examine how 
successfully the photos were treated with Primatte. 

Now go to File> Automate> Batch. This opens the Batch 
dialog box.

[ fi gure 11 ] The Save As dialog. Most 
likely, youʼll want to change the fi le name 
and save to a new folder.

[ fi gure 12 ] Your fi nal Action and 
the little ʻStopʼ button that could.

[ fi gure 10 ]  
Second step 
in our Action.
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step 08: set up the batch
There are only a few things that you need to do inside 
the Batch dialog box. [ fi gure 13 ]  

a. Select the Action to play.
b. Choose the ʻSourceʼ folder to pull fi les from.
c. Choose the ʻDestinationʼ folder to resave them to.
d.  Choose your ʻFile Namingʼ convention. For our fi les, 

we are adding in the word ʻ-newʼ between the fi le 
name and the extension. 

Now run the Batch by clicking ʻOkʼ. One of the great 
aspects of Batching is that you can work on your 
computer outside of Photoshop while itʼs doing its work.

step 09: look at the files
Letʼs look at how our fi les came out. Go to your hard drive 
and open the treated fi les and original fi les to compare. 

[ fi gure 13 ] The Batch dialog box. 

a

b

c

d

Here is an opinion about how our fi ve 
photos came out using the Batch.

[ Image 1 ] This is the image that our 
Primatte mask settings were based on and 
the Action/Batch used. Of course, the mask 
looks great because we set up Primatteʼs 
color parameters to treat this photo. 

[ Image 2 ] This photo has 
exactly the same lighting 
conditions and color range as 
Image 1. Notice how even the 
blue tone of the screen looks. 
The mask for this image 
came out terrifi cally because 
its color distribution is the 
same as the image the mask 
settings were based on.
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[ Image 3 ] This photo also 
has conditions very similar to 
Image 1. Therefore, the mask 
came out good. But notice the 
dark band along the top of the 
photo. This is a remanent of the 
screenʼs scaff hold that showed 
in the original photo. Its deep 
blue was too outside of the 
pre-determined mask settings, 
so only part of the image was 
removed. 

[ Image 4 ] The blue screen 
colors are in the range that 
Primatte has been told to 
keep. Good mask but same 
remnant problem as in 
Image 3. Also, a wire from 
the studio setup is visible.  

The solution to color 
remanents like the wire 
and scaff old is very simple. 
Before you run Primatte, 
crop out or delete any 
image area that will cause 
a problem. Typically this 
will be a blocky area that 
is very easy to isolate. You 
can also approach this from 
the opposite end and crop/
delete after the photo has 
been masked. [ fi gure 14 ]

[ Image 5 ] The mask did not 
work very well on this image. 
The blue was removed but a 
ghost of its colors is left behind.
This is because the blue screen 
looks considerably darker than 
in the other photos, which 
means the mask settings are not 
appropriate. This photo would 
need to be retreated by Primatte 
with diff erent settings.

[ fi gure 14 ] In Photoshop, you can use 
the Crop tool (shown at right) or the 
Delete key to remove elements that 
werenʼt erased by Primatteʼs masking. 
Remember, Primatte only removes a 
single color or color range.
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in conclusion (and another example!) 
As you can see, tying Primatte into an Action, and then a Batch, is a very simple 
process. However, an automated approach to Primatte will not work ideally 
with every group of photographs. Its success really comes down to how your 
photographs look. 

Auto-processing works best on photos that were taken under similar lighting 
conditions and contain the same subject matter. That was the case with the fi ve 
photos we worked with in this tutorial. One model was photographed in a single 
session under the same lighting setup. If we take the same Action and process it 
with two unrelated photos, look at what happens:

As with any photography, we always suggest a reality check! Do some 
preliminary tests before using Primatte in a Batch situation under a deadline. 

[ Image 6 ] This photo has  
the same lighting conditions 
and model as Image 1, but 
the back screen is green 
instead of blue. This throws 
off  the color model created 
for the Action and Primatte is 
ineff ective in creating a mask. 
You would need to create a 
new mask for this photo.

[ Image 7 ] Diff erent model, 
diff erent back screen. Still 
blue, though, which means 
the Actionʼs mask settings 
have some eff ect. The results 
are similar to Image 5 since 
the blue is removed, but not 
fully. Still, you would need 
to create a new mask for this 
photo.
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tech note about actions
There is a fi nal piece of information to point out about 
our Action. When you record functions that include a 
dialog box, the settings recorded are the ones in the 
dialog box at the time of the recording. When you run the 
Action, it uses those dialog settings. 

issue with the dialog icon
Letʼs say you want to use your Primatte Action to treat 
multiple fi les without entering into Batch. In Step 6 of 
this tutorial we recorded a ʻFile> Save Asʼ dialog. 

The Action will use the fi le name originally recorded. If 
you save to the same folder, this will overwrite the fi le on 
your hard drive that is currently using that name. This is 
not very productive!

Luckily, there is a very simple solution. Simply activate 
the Dialog button next to the ʻSaveʼ function in the Action 
palette. [ fi gure 16 ] 

This button serves as a prompt. When your Action runs, 
the Dialog button tells Photoshop to pause at the Save 
As dialog and allow you to enter in custom information. 
In this case, you will type in a new fi le name. [ fi gure 17 ]

not an issue for batching
A Batch process does not run into this issue. This is 
because a Batch is designed to treat groups of images, so 
it has (re)naming functions built into its dialog box. 

You will need to turn off  the Dialog icon for your Save 
function when you run the Primatte Action through a 
Batch. Otherwise the Batch will pause on each fi le for a 
custom name to be entered. Again, not very productive…

Have questions about this information? Contact us at 
info@digitalanarchy.com. 

[ fi gure 15 ] The Dialog icon is turned off . 

[ fi gure 16 ] The Dialog icon is turned on. 

[ fi gure 17 ] With the Dialog icon active, 
the Action will prompt you to enter in a 
new fi le name. 


